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คำนำ 
 

งานบริการเทคโนโลยี กองบริการเทคโนโลยีสารสนเทศและการสื่อสาร มีภารกิจในการบริหารจัดการ

ระบบงานสารบรรณ และการจัดสงหนังสือราชการผานระบบสารบัญอิเล็กทรอนิกส NU e-Document โดย

การใชระบบสารบรรณอิเล็กทรอนิกสนี้ ชวยใหการทำงานของบุคลากรในองคกรเปนไปอยางมีประสิทธิภาพ

และรวดเร็วมากขึ้น นอกจากนี้ยังชวยลดการใชกระดาษและยังชวยลดการใชทรัพยากรธรรมชาติไดอีกดวย 
 

การทำงานระบบสารบรรณอิเล็กทรอนิกสในรปูแบบ Paperless เปนการทำงานที่เกี่ยวของกับการใช

เทคโนโลยีสารสนเทศเพ่ือสงและรับเอกสาร และมีการเก็บเอกสารในระบบอิเล็กทรอนิกส ทำใหสามารถเขาถึง

เอกสารไดงายและรวดเร็ว ซึ่งหากใชงานรวมกับลายเซ็นดิจิทัล หรือ Digital Signature ซึ่งเปนเทคโนโลยีที่ใช

ในการยืนยันความถูกตองของเอกสารอิเล็กทรอนิกส โดยใชวิธีการเขารหัสขอมูลและการตรวจสอบความ

ถูกตองของเอกสาร ซึ่งจะชวยลดความเสี่ยงในการปลอมแปลงเอกสารและเพิ่มความนาเชื่อถือไดมากยิ่งขึ้น  
 

ดังนั้น คูมือการทำงานระบบสารบรรณอิเล็กทรอนิกส ในรูปแบบ Paperless เลมนี้ จึงไดจัดทำเพื่อ

เปนแนวปฏิบัติที่ดี สำหรับผูที่มีสวนเกี่ยวของในระบบงานสารบรรณ เพื่อชวยแนะนำวิธีปฏิบัติที่ถูกตองใหแก

บุคลากรในองคกร และเพ่ือใหมีรูปแบบการทำงานที่มีสอดคลองกันอยางเปนระบบและมีประสิทธิภาพ  

 

 

ดร.ธนวัฒน พูลเขตนคร 

นักวิชาการคอมพิวเตอร 
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การสรางลายเซ็นดจิิทัล (e-Signature) ดวยโปรแกรม Microsoft Word 

1. เขียนลายเซ็นลงในกระดาษ A4 แลวใชโทรศัพทมือถือ ทำการถายภาพลายเซ็นที่ตองการใชงาน 

2. หลังจากนั้นใหนำภาพลายเซ็น เปดในโปรแกรม Microsoft Word 

3. ไปที่แถบเมนคูำสั่ง Insert > Pictures > This Device.. 

 
 

4. เลือกภาพลายเซ็น ที่ตองการจัดทำเปนลานเซ็นดิจิทัล แลวกดปุม Insert 

 
 

5. เม่ือเปดภาพลายเซ็นในโปรแกรม Microsoft Word แลว ใหทำการคลิกขวาที่ภาพ แลวเลอืกเมนูคำสั่ง 

Format Picture… 

(1) ต้ังคา Sharpness เทากับ 80 

(2) ต้ังคา Brightness เทากบั 50 
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6. ยอปรบัขนาดตามที่ตองการ และตัดพ้ืนท่ีใหเหลือเฉพาะสวนที่ใชงาน โดยใชเมนูคำส่ัง Crop 

 
 

 

7. ลบพ้ืนหลังของภาพลายเซน็ดิจิทัล โดยดับเบิ้ลคลิกท่ีภาพแลวเลอืกที่เมนูคำส่ัง Picture > Set 

Transparent Color แลวนำเมาสพอยเตอรไปคลิกท่ีพื้นหลังของลายเซ็นดิจิทัล 
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8. ใหคลิกขวาที่ภาพลายเซ็น แลวเลือกที่เมนูคำสั่ง Save as Picture 

 
 

9. ใหดำเนินการ ตั้งชื่อไฟล และเลือกชนิดของไฟลเอกสารเปน Portable Network Graphics (*.png)  

บันทึกไฟล เลือกพ้ืนที่จัดเก็บแลวกดปุม Save 

 
 

10. เสร็จสิ้นการสรางลายเซ็นดิจิทัล 

 

 

อางอิง : 

Smart & Easy Work with SaraLee (2566). Word: สรางลายเซ็น electronic และเก็บไวใชงานเรื่อยๆ 

ทำงายและไวใน 5 นาท.ี สืบคนเมื่อวันท่ี 11 พฤษภาคม 2566. จากเว็บไซต 

https://www.youtube.com/watch?v=0ha0sRGYGco 
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การตดิต้ังโปรแกรม Adobe Acrobat Reader 

1. เขาไปที่เว็บไซต Google แลวคนหาคำวา Acrobat Reader 

2. คลิกลิงคเพื่อทำการดาวนโหลดโปรแกรม แลวคลิกที่ปุม Download Acrobat Reader 

 

 
 

3. ทำการดาวนโหลดไฟลตดิต้ัง และจัดเก็บไฟลไวท่ีเคร่ืองคอมพิวเตอร  
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4. ดับเบิ้ลคลิกที่ไฟล readerdc64_en_xa_mdr_install เพื่อติดต้ังโปรแกรม Acrobat Reader  

 

 

 

5. เม่ือโปรแกรมติดต้ังเรียบรอยแลว ใหคลิกท่ีปุม Finish 

6. เสร็จสิ้นการติดต้ังโปรแกรม Adobe Acrobat Reader 

 

การตดิต้ัง Adobe Acrobat Extended Asian Language Font Pack 

การพิมพขอความภาษาไทย ในโปรแกรม Adobe Acrobat Reader จำเปนจะตองติดตั้ง Adobe Acrobat 

Extended Asian Language Font Pack เพิ่มเติม ดังนี้ 

7. เขาไปที่เว็บไซต Google แลวคนหาคำวา “Acrobat Font Pack” 
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8. คลิกดาวนโหลดตาม Version ของ Adobe Acrobat Reader ของเคร่ืองคอมพิวเตอร และจดัเก็บไฟลไว

ที่เครื่องคอมพิวเตอร 

 

 
 

9. ดับเบิ้ลคลิกที่ไฟล AcroRdrALSDx64_2200120085_all_DC.msi เพ่ือติดต้ังโปรแกรม Adobe Acrobat Reader  

 

 

10. เม่ือโปรแกรมติดต้ังเรียบรอยแลว ใหคลิกท่ีปุม Finish 

11. เสร็จสิ้นการติดต้ัง Adobe Acrobat Extended Asian Language Font Pack 
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ขั้นตอนการปดใชงาน Acrobat Reader เวอรชันใหม 

12. คลิกท่ีปุม Menu (ไอคอนสามขีดมุมบนซายของหนาจอ) จากนั้นเลื่อนลงไปยังเมนูดานลางและคลิกที่คำสั่ง 

“Disable new Acrobat Reader” หลังจากนั้นคลิกที่ปุ ม Restart เพื่อใหโปรแกรมกลับไปใชหนาตา

เวอรชันเกา (Classic View) 

 
 

13. เสร็จสิ้นข้ันตอนการปดใชงาน Acrobat Reader เวอรชันใหม 
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การขอใบรับรองอิเล็กทรอนิกส (Digital Certificate) 

1. เขาไปที่เว็บไซต https://cert.nu.ac.th เพื่อขอใบรับรองอิเล็กทรอนิกส (Digital Certificate)   

2. ทำการ Login โดยใช NU Account ของมหาวิทยาลัยเพื่อทำการดาวนโหลดใบรับรองอิเล็กทรอนิกส 

(Digital Certificate) สำหรับการการสรางลายเซ็นดิจิทัล (Digital Signature) 

 
 

3. ทำการต้ัง Password สำหรับใบรับรองอิเล็กทรอนิกส (Digital Certificate) 

 
 

**หมายเหตุ Password ตองมีความยาว 10-20 ตัวอักษร ไมมีอักขระพิเศษ และตองจดจำได ถาหาก ลืม 

จะตองดำเนินการขอใบรองอิเล็กทรอนิกส ใหม และไมควรเผยแพร Password นี้ใหแกผูอ่ืน 

 

4. ทำการดาวนโหลดไฟล ใบรับรองอิเล็กทรอนิกส User Certificate และใบรับรองอิเล็กทรอนิกส Trust 

Root CA ดังนี ้

- คลิกที่ปุ ม “Download User Certificate” เพื่อดาวนโหลดไฟลใบรับรองอิเล็กทรอนิกส User 

Certificate 
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- คลิกที ่ปุ ม “Download TrustedCert” เพื ่อดาวนโหลดไฟลสำหรับติดตั้งใชงานใบรับรอง 

อเิล็กทรอนิกส Trust Root CA  

**หมายเหตุ ตองทำการดาวนโหลดไฟลใหครบท้ัง 2 ไฟล 

 

5. ดาวนโหลดใบรับรองอิเล็กทรอนิกส User Certificate โดยคลิกที่ปุมเมนู Download User Certificate 

 
 

6. เลือกโฟลเดอรที่ตองการจัดเก็บใบรับรองอิเล็กทรอนิกส User Certificate แลวกดปุม Save 

 
 

7. ดาวนโหลดใบรับรองอิเล็กทรอนิกส Trust Root CA โดยคลิกที่ปุมเมนู Download TrustedCert 
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8. เลือกโฟลเดอรที่ตองการจัดเก็บใบรับรองอิเล็กทรอนิกส Trust Root CA แลวกดปุม Save 

 
 

9. เสร็จสิ้นการขอใบรับรองอิเลก็ทรอนิกส (Digital Certificate) 
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การตดิต้ังใบรับรองอิเล็กทรอนิกส User Certificate  

1. ไปที ่โฟลเดอรที ่จัดเก็บไฟลใบรับรองอิเล็กทรอนิกส User Certificate เพื ่อทำการติดตั ้งใบรับรอง

อิเล็กทรอนิกส User Certificate แลวทำการคลิกขวาที่ชื่อไฟลชื่อ NU Account ลงทายดวยนามสกุล 

.P12 แลวคลิกที่เมนูคำส่ัง Install PFX  

 
 

2. คลิกที่ปุม Next 
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3. คลิกที่ปุม Next 

 
 

4. ใส Password ของไฟลใบรับรองอิเล็กทรอนิกส User Certificate ที่ไดต้ังคาไวในข้ันตอนการขอใบรับรอง

อเิล็กทรอนิกส (Digital Certificate) และคลิกตวัเลือก  ตามภาพ จากนั้นคลิกที่ปุม Next 
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5. คลิกท่ีปุม Next  

 
 

6. คลิกท่ีปุม Finish 
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7. คลิกปุม OK  

 
 

8. คลิกปุม OK  

 
 

9. เสร็จสิ้นการติดตั้ง User Certificate 
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การตดิต้ังใบรับรองอิเล็กทรอนิกส Trust Root CA  

1. ไปที่โฟลเดอรท่ีจัดเกบ็ไฟลใบรับรองอิเล็กทรอนิกส Trust Root CA แลวทำการคลิกขวาที่ชื่อไฟล 

TUCTrustedCert.zip แลวเลือกเมนูคำสั่ง Extract All.. 

 
 

2. คลิกที่ปุม Extract เพ่ือทำการแตกไฟล 

 
 

3. เม่ือทำการแตกไฟล TUCTrustedCert.zip เรียบรอยแลวจะม ี2 ไฟล    
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4. ทำการติดต้ังใบรับรองอิเล็กทรอนกิส Trust Root CA โดยทำการคลิกขวาที่ไฟลชื่อ TUCTrustedCert 

แลวคลิกเลือกที่เมนูคำสั่ง Install Certificate  

 
 

5. คลิกที่ปุม Open 
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6. คลิกท่ีปุม Next 

 
 

7. คลิกท่ีปุม Next 
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8. ทำการเลือก Place all certificates in the following store > ทำการเลือกโฟลเดอร Trusted Root 

Certification Authorities แลวคลิกที่ปุม OK 

 
 

9. คลิกท่ีปุม Next 
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10. คลิกท่ีปุม Finish 

 
 

11. คลิกปุม Yes เพื่อทำการยืนยันการติดตั้ง  
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12. คลิกปุม OK  

 
 

13. เสร็จสิ้นการติดต้ัง Trust Root CA 
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การสรางลายเซ็นดจิิทัล (Digital Signature) ดวยโปรแกรม Adobe Acrobat 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ท่ีตองการลงลายเซน็ดิจิทัล (Digital Signature) 

2. เลือกแถบเมนูคำส่ัง Tool > Certificates แลวเลือกท่ีเมนคูำส่ัง Digitally Sign 

 
 

3. ลากเมาสพอยเตอร เพ่ือกำหนดหนดพ้ืนที่ในการวางลายเซ็นดิจิทัล (Digital Signature) 

 
 

4. ใหเลือกที่ปุม Continue 

 
 

5. เลือกลายเซ็น ที่ตองการนำมาใชเปนลายเซน็ดิจิทัล 

 
  



22 

6. ทำการสรางลายเซ็นดิจิทัล (Digital Signature) โดยคลิกที่ปุม Create เลือกลายเซ็นดิจิทัลที่ตองการใช

งาน > เลือกที่แถบ Image แลวเลือกที่เมนู Browse > และต้ังชื่อลายเซ็นดิจิทัล (Preset name) แลวกด

ที่ปุม Save 

 
 

 
 

7. หลังจากนั้นกดที่ปุม Sign 
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8. เลือกโฟลเดอรที่ตองการจัดไฟลที่ลงลายเซ็นดิจิทัล แลวกดปุม Save 

 
 

9. ถามีปอปอัพขอความนี้ ใหคลิกที่ปุม Allow  

 
 

10. เสร็จสิ้นการสรางลายเซ็นดิจิทัล (Digital Signature) 
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การเพิ่มใบรับรองอเิล็กทรอนิกสที่นาเชื่อถอื (Add to Trusted Certificate) 

1. เปดไฟล PDF ที่ไดลงลายเซ็นดิจิทัล (Digital Signature) 

2. ในกรณทีี่ใบรับรองอิเล็กทรอนิกส (Digital Certificate) มีปญหา หรือขึ้นขอความวา “At least one 

signature has problems.” 

 

 
3. คลิกที่ลายเซ็น แลวคลิกที่ปุม Signature Properties.. 

 
4. คลิกปุม Show Signer’s Certificate.. 
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5. คลิกที่แถบคำสั่ง Trust แลวคลิกปุม Add to Trusted Certificate.. 

 
6. แลวคลิกที่ปุม OK 
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7. คลิกตัวเลือก  ตามภาพ จากนั้นคลิกที่ปุม OK 

 
8. แลวคลิกที่ปุม OK 
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9. แลวคลิกที่ปุม Close 

 
10. เสร็จสิ้นข้ันตอน การเพ่ิมใบรับรองอิเล็กทรอนิกสท่ีนาเชื่อถือ 
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การตรวจสอบลายเซ็นดิจิทัล (Digital Signature) 

1. เปดไฟล PDF ทีไ่ดลงลายเซ็นดิจิทัล (Digital Signature)  

2. คลิกที่ลายเซ็น แลวคลิกที่ปุม Signature Properties.. 

 

 
 

3. คลิกปุม Show Signer’s Certificate.. 
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4. ลายเซ็นดิจิทัล (Digital Signature) ที่ถูกตองจะตองไดรับใบรับรองอิเล็กทรอนิกส (Digital Certificate) 

จาก Naresuan University Certification Authority  

 
 

5. หรือ สามารถดูที่สัญลักษณตามภาพ และคลิกที่ปุม Signature Panel เพื่อตรวจสอบลายเซ็นดิจิทัล 

(Digital Signature) ที่ถูกตองจะตองไดรับใบรับรองอเิล็กทรอนิกส (Digital Certificate) 

 
 

* ทั้งนี้ เพื่อใหเปนไปตามพระราชบัญญัติวาดวยธุรกรรมทางอิเล็กทรอนิกส พ.ศ.๒๕๔๔ และที่แกไขเพิ่มเติม  

การรับและการสงหนังสืออิเล็กทรินิกสของสวนงานและหนวยงานนั ้น ควรใชใบรับรองดิจิทัล (Digital 

Certificate) ท่ีออกโดยมหาวิทยาลัย หรือโดยหนวยงานที่เชื่อถือได เทานั้น 
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การใชงานลายเซ็นดิจิทัล (Digital Signature) ดวยโปรแกรม Adobe Acrobat 

1. เปดไฟลเอกสาร PDF ท่ีตองการลงลายเซ็นดิจิทลั (Digital Signature) 

2. เลือกแถบเมนูคำส่ัง Tool > Certificates แลวเลือกท่ีเมนคูำส่ัง Digitally Sign 

 
 

3. ลากเมาสพอยเตอร เพ่ือกำหนดหนดพ้ืนที่ในการวางลายเซ็นดิจิทัล (Digital Signature) 

 
 

4. ใหเลือกที่ปุม Continue 

 
 

5. เลือกลายเซ็นที่ไดสรางไว นำมาใชเปนลายเซ็นดิจิทัล หลังจากนั้นกดที่ปุม Sign 
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6. หลังจากกดท่ีปุม Sign แลวจะปรากฏลายเซ็นดิจิทัล (Digital Signature) ในไฟลเอกสาร PDF ดังภาพตัวอยาง 

 

 

7. เลือกโฟลเดอรที่ตองการจัดไฟลที่ลงลายเซ็นดิจิทัล แลวกดปุม Save 

 
 

8. ถามีปอปอัพขอความนี้ ใหคลิกที่ปุม Allow  

 
 

9. เสร็จสิ้นการสรางลายเซ็นดิจิทัล (Digital Signature) 
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การสรางตรายางดิจิทัล (Stamp) ช่ือสกุลและตำแหนง ดวยโปรแกรม Microsoft Word 

1. เปนโปรแกรม Microsoft Word แลวพิมพขอความที่ตองการ สรางตรายางดิจิทัล (Stamp) 

 
 

2. ใหดำเนินการบันทกึไฟล เปนไฟล PDF โดยเขาไปท่ีเมนูคำสั่ง File > Save As แลวตั้งชื่อไฟล และเลือก

ชนิดของไฟลเอกสารเปน PDF(*.pdf) เลือกพื้นที่จัดเก็บแลวกดปุม Save 

 

3. เสร็จสิ้นการสรางตรายางดิจิทัล (Stamp) 
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การนำตรายางดิจิทัล (Stamp) ชื่อสกุลและตำแหนง ไปใชที่โปรแกรม Adobe Acrobat 

การสรางตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Stamp Palette 

 
 

3. นำเขาไฟล Stamp ที่ไดทำการสรางไวสำหรับใชงานที่โปรแกรม Adobe Acrobat โดยคลิกที่ปุม 

Import…  

 
 

4. เปดไฟล Stamp ที่ไดทำการสรางไวสำหรับใชงานท่ีโปรแกรม Adobe Acrobat โดยคลิกที่ปุม Browse… 

x  
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5. คลิกเลือกที่พ้ืนท่ีแสดงตัวอยาง (Sample) แลวคลิกที่ปุม OK 

 
 

6. จัดกลุมเครื่องมือโดยทำการตั้งชื่อ Category (กรณีท่ีตองการสรางกลุมเครื่องมือใหม) หรือทำการเลือก 

Category ที่ไดสรางไวแลว หลังจากนั้นใหทำการตั้งชื่อ Stamp แลวกดปุม OK 
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การใชงานตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Stamp  

 
 

3. เลือกตรายางดิจิทัล (Stamp) ที่ตองการใชงาน แลวเลือกตำแหนงที่วางตรายาง (Stamp) ลงในเอกสาร 

 
 

การแกไขใชงานตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Custom Stamps 
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4. โดยหากตองการแกไขตรายางดิจิทัล (Stamp) ใหทำการเลือกชื่อตรายางดิจิทัล (Stamp) แลวเลือกที่ปุม

เมนู Edit… 

 
 

5. ทำการแกไขตรายางดิจิทัล (Stamp) แลวทำการคลิกที่ปุม OK 

 
 

6. เสร็จสิ้นการใชงานตรายางดิจิทัล (Stamp) 

 

 

 

  



37 

การสรางตรายางดิจิทัล (Stamp) ลงรับเอกสาร ดวยโปรแกรม Microsoft Word 

1. เปนโปรแกรม Microsoft Word แลวพิมพขอความที่ตองการ สรางตรายางดิจิทัล (Stamp) 

 

 

 

 

 

 

 

2. กำหนดหนากระดาษ ใหพอดีกับขนาดของตรายางดจิิทัล (Stamp) โดยเขาไปท่ี เมนูคำสั่ง Layout > 

Page Setup  

(1) ตั้งคา Width เทากับ 6.8 cm หรือใหไดขนาดเทากับตรายางดิจิทัล (Stamp) ที่สราง 

(2) ตั้งคา Height เทากับ 4.2 cm หรือใหไดขนาดเทากับตรายางดิจิทลั (Stamp) ที่สราง 

 
 

3. ตั้งคาขอบกระดาษ โดยเลือกที่แถบเมนู Margins  

(1) ตั้งคา Top  เทากับ 0.2 

(2) ตั้งคา Bottom  เทากับ 0.2 

(3) ตั้งคา Left  เทากับ 0.2 

(4) ตั้งคา Right เทากับ 0.2 

กองบริการเทคโนโลยีสารสนเทศและ

การสื่อสาร 

รับที…่……………………………………………… 

วันท่ี........................................................ 

เวลา........................................................ 
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4. เมื่อกำหนดคาหนากระดาษ และขอบกระดาษ เสร็จสิ้นแลว ใหกดปุม OK 

 
 

5. ใหดำเนินการบันทกึไฟล เปนไฟล PDF โดยเขาไปท่ีเมนูคำสั่ง File > Save As แลวตั้งชื่อไฟล และเลือก

ชนิดของไฟลเอกสารเปน PDF(*.pdf) เลือกพื้นที่จัดเก็บแลวกดปุม Save 

 

6. เสร็จสิ้นการสรางตรายางดิจิทัล (Stamp) 
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การนำตรายางดิจิทัล (Stamp) ลงรับเอกสาร ไปใชท่ีโปรแกรม Adobe Acrobat 

การสรางตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Stamp Palette 

 
 

3. นำเขาไฟล Stamp ที่ไดทำการสรางไวสำหรับใชงานที่โปรแกรม Adobe Acrobat โดยคลิกที่ปุม 

Import…  

 
 

4. เปดไฟล Stamp ที่ไดทำการสรางไวสำหรับใชงานท่ีโปรแกรม Adobe Acrobat โดยคลิกที่ปุม Browse… 

x  
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5. คลิกเลือกที่พ้ืนท่ีแสดงตัวอยาง (Sample) แลวคลิกที่ปุม OK 

 
 

6. จัดกลุมเครื่องมือโดยทำการตั้งชื่อ Category (กรณีท่ีตองการสรางกลุมเครื่องมือใหม) หรือทำการเลือก 

Category ที่ไดสรางไวแลว หลังจากนั้นใหทำการตั้งชื่อ Stamp แลวกดปุม OK 

 
 

7. เลือกตำแหนงที่วางตรายาง (Stamp) ลงในเอกสาร 
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การใชงานตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Stamp  

 
 

3. เลือกตรายางดิจิทัล (Stamp) ที่ตองการใชงาน แลวเลือกตำแหนงที่วางตรายาง (Stamp) ลงในเอกสาร 

 
 

การแกไขใชงานตรายางดิจิทัล (Stamp) 

1. เปดโปรแกรม Adobe Acrobat แลวเปดไฟล PDF ที่ตองการนำตรายางดิจิทัล (Stamp) ใชงาน 

2. เลือกแถบเมนูคำสั่ง Tool > Stamp แลวเลือกที่เมนูคำสั่ง Custom Stamps 
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3. โดยหากตองการแกไขตรายางดิจิทัล (Stamp) ใหทำการเลือกชื่อตรายางดิจิทัล (Stamp) แลวเลือกที่ปุม

เมนู Edit… 

 
 

4. ทำการแกไขตรายางดิจิทัล (Stamp) แลวทำการคลิกที่ปุม OK 

 
 

5. เสร็จสิ้นการใชงานตรายางดิจิทัล (Stamp) 
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ส้ินสุด 

ข้ันตอนการรับ-สงหนังสือราชการในรูปแบบอิเล็กทรอนิกส 
 

กระบวนการสงหนังสือราชการ 

ผังการดำเนินงาน  รายละเอียดการดำเนินงาน เครื่องมือ/ผูใชงาน 

                 เร่ิมตน 
 เตรียมขอมูลและรายละเอียดของ 

หนังสือราชการ 
เจาของเร่ือง 

 

         ออกเลขหนงัสือ 
 ออกเลขหนังสือ โดยจองเลขใน 

ระบบสารบรรณอิเล็กทรอนิกส 
NU e-Document 

 

 

เจาหนาที่สารบรรณ 

 
         สรางไฟลหนังสือ 

 ใสเลขหนังสือท่ีจองไวในไฟล 
หนังสือราชการ และบันทึกไฟล 
เปนรูปแบบ PDF ทุกฉบับที่ตอง 
สงถึงสวนงาน/หนวยงาน 

 

 

เจาของเร่ือง 

แกไข 
                     ไฟลถูกตอง 

 ตรวจสอบความถูกตองของไฟล 
หนังสือราชการ กอนเสนอลงนาม  

หัวหนาหนวยงาน 

 
              เสนอลงนาม 

 เสนอหนังสือราชการเพ่ือลงนาม 
โดยจัดเก็บไวในโฟลเดอร 

เสนอพิจารณา 

 

หัวหนาหนวยงาน 
หรือเจาหนาที่สารบรรณ 

 

         ลงลายเซ็นดิจิทัล 
 ลงลายเซ็นดิจิทัล บันทึกและยาย 

ไฟลจัดเก็บไวในโฟลเดอร 
พิจารณาและลงนามแลว 

 

 

ผูบริหาร 

แกไข 
                      ไฟลถูกตอง 

 ตรวจสอบความถูกตอง การลง 
ลายเซ็นดิจิทัล ครบถวนหรือไม  

เจาหนาที่สารบรรณ 
 

               สงเอกสาร 
 สงเอกสาร ในระบบสารบรรณ 

อิเล็กทรอนิกส NU e-Document  

เจาหนาที่สารบรรณ 
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กระบวนการรับหนังสือราชการ 

ผังการดำเนนิงาน  รายละเอียดการดำเนินงาน เคร่ืองมือ/ผูใชงาน 

เร่ิมตน 
 สงหนังสือราชการ ในระบบสาร 

บรรณอิเล็กทรอนิกส 
NU e-Document 

 
เจาของเร่ือง 

 
 แกไข 

 เปดระบบสารบรรณ 
อิเล็กทรอนิกส 
NU e-Document และ 
ตรวจสอบความถูกตองของ 
หนังสือราชการ ในรูปแบบ PDF 

 

 

 

เจาหนาที่สารบรรณ 

 

 
 ลงรับหนังสือราชการ ในระบบ 

สารบรรณอิเล็กทรอนิกส 
NU e-Document 

 

 

เจาหนาที่สารบรรณ 

 
 

เตรียมไฟลหนังสือ 

 
 

 ดาวนโหลดไฟลจากระบบสาร 
บรรณอิเล็กทรอนิกส NU e- 
Document และเตรียมไฟลกอน 
เสนอผูบริหาร เชน การ Stamp 
การส่ังการ/ชื่อและตำแหนง/การ 
แนบไฟล 

 
 
 

 

เจาหนาที่สารบรรณ 

  ตรวจสอบความถูกตองของไฟล 
หนังสือราชการ กอนเสนอลงนาม  

หวัหนาหนวยงาน 

 

เสนอลงนาม 

 เสนอหนังสือราชการเพ่ือลงนาม 
โดยจัดเก็บไวในโฟลเดอร 

เสนอพิจารณา 

 

หัวหนาหนวยงาน 
หรือเจาหนาที่สารบรรณ 

แกไข ลงลายเซ็นดิจิทัล 
 ลงลายเซ็นดิจิทัล บนัทึกและยาย 

ไฟลจัดเก็บไวในโฟลเดอร 
พิจารณาและลงนามแลว 

 

 

ผูบริหาร 

 
ไฟลถูกตอง 

 ตรวจสอบความถูกตอง การลง 
ลายเซ็นดิจิทัล ครบถวนหรือไม  

เจาหนาที่สารบรรณ 
 

สงเอกสาร 
 สงเอกสาร ในระบบสารบรรณ 

อิเล็กทรอนิกส NU e-Document  

เจาหนาที่สารบรรณ 
 

ส้ินสุ 

ไฟลถูกตอง 

ไฟลถูกตอง 
แกไข 

ลงรับในระบบ e-Document 
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บรรณานุกรม 

 

Smart & Easy Work with SaraLee (2566). Word: สรางลายเซ็น electronic และเก็บไวใชงานเรื่อยๆ 

ทำงายและไวใน 5 นาท.ี สืบคนเมื่อวันท่ี 11 พฤษภาคม 2566. จากเว็บไซต 

https://www.youtube.com/watch?v=0ha0sRGYGco 

 




